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ค่อนชีวิตของผมท�ำงำนเกี่ยวกับกำรออกแบบภำพกรำฟิกเป็นอำชีพ และสิ่งหนึ่งที่ควบคู่กับ

งำนกรำฟิกของผม คือกำรวำดภำพกำร์ตูนประกอบในงำนต่ำงๆ ตัวกำร์ตูนจะเติมเต็มให้งำนดูมี

ชวีติชวีำ น่ำสนใจมำกขึ้น ผมจะใช้โปรแกรม Illustrator ในกำรรงัสรรค์ ออกแบบและวำดตวักำร์ตูน

ต่ำงๆ เรำจะได้ภำพเวกเตอร์กำร์ตูนสวยๆ ขึ้นมำ ซึ่งถ้ำมกีำรย่อ/ขยำยรูปนั้น ยงัไงกไ็ม่แตก นั่นคอื

ข้อดขีองภำพเวกเตอร์นั่นเอง นอกจำกนี้แล้วยงัจะเหมำะกบักำรวำดภำพมำก ทั้งกำรดดั ปรบัแต่งเส้น 

กท็�ำได้ง่ำย ยดืหยุ่นมำก 

ผมจึงเขียนหนังสือเล่มนี้ขึ้นมำ เพื่อน�ำเทคนิคกำรวำดภำพเวกเตอร์ของผมมำบอกมำเล่ำให้

ทุกท่ำนได้อ่ำนและลองท�ำตำมดูครับ เป้ำหมำยคืออยำกให้ทุกท่ำนวำดกำร์ตูนในแบบของตัวเอง

ได้ สำมำรถสร้ำงสรรค์งำนได้ไม่จ�ำกัด ผู้อ่ำนที่เป็นมือใหม่ไม่เคยใช้โปรแกรมมำก่อนจนถึงระดับ

กลำงใช้เป็นแบบงูๆ ปลำๆ กอ็่ำนและท�ำตำมได้สบำยมำก พฒันำควำมสำมำรถคณุได้แน่นอนครบั

สิ่งส�ำคัญเมื่อทุกท่ำนวำดกำร์ตูนเป็นแล้วมันจะต้องสร้ำงรำยได้เข้ำกระเป๋ำสิครับ นอกจำก

เทคนิคกำรวำดแล้วหนังสือเล่มนี้ยังแนะน�ำวิธีกำรสมัคร วิธีกำรส่งขำยภำพเวกเตอร์ไปที่เว็บขำย

ออนไลน์ชื่อดงัอย่ำง Shutterstock วธิกีำรผูกบญัช ี PayPal จนถงึกำรเบกิเงนิจำกกำรขำยภำพมำสู่

บัญชีธนำคำรแบบละเอียดทุกขั้นตอน มำสร้ำงรำยได้แบบ Passive Income หำเงินเข้ำกระเป๋ำไป

ด้วยกนันะครบั 

อนนั วำโซะ 

ช่องทำงกำรตดิต่อ

เฟซบุ๊คเพจ :  Graphic Design by อ อั๋น

อเีมล  : bingo_aun@hotmail.com
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ขอบคณุทกุท่ำนที่เกี่ยวข้องกบัหนงัสอืเล่มนี้ครบั

ขอบคณุผู้อ่ำนทกุท่ำนที่สนใจ ตั้งใจอ่ำน และอดุหนนุหนงัสอืเล่มนี้ ตลอดจนหนงัสือ

กรำฟิกเล่มอื่นๆ ของผม 

ขอบคณุจรงิๆ ครบั

อนนั วำโซะ
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หลำยๆ คนคงอยำกมรีำยได้แบบ Passive Income ท�ำงำนครั้งเดยีวแล้วรอเงนิไหลเข้ำบญัชอียู่ใช่มั้ย กำรขำยภำพ

ผ่ำนเว็บ Microstock ก็เป็นอีกทำงหนึ่งที่จะท�ำให้คุณมีรำยได้แบบนี้ขึ้นมำ มีเว็บมำกมำยที่เรำสำมำรถส่งภำพเวกเตอร์ 

ภำพถ่ำย หรอืคลปิวดิโีอฝำกขำยแบ่งเปอร์เซน็ต์กบัเวบ็นั้นๆ หลำยๆ ท่ำนท�ำจนมรีำยได้แซงเงนิเดอืนไปแล้ว บำงคนออก

จำกงำนมำเพื่อท�ำภำพขำยแบบจรงิจงัเลยทเีดยีว หรอืบำงคนกท็�ำเพื่อเป็นรำยได้เสรมิควบคู่กบังำนประจ�ำชวีติกช็ลิไปอกี

แบบ ยิ่งถ้ำคณุเป็นสำยวำด ชอบหรอืสนใจกำรวำดเป็นทนุเดมิอยู่แล้วยิ่งเข้ำทำงเลย 

ผมอยำกแนะน�ำให้คุณมำฝึกใช้โปรแกรม Illustrator วำดภำพเวกเตอร์ ส่งขำยออนไลน์ได้เงินไปใช้กันเล่นๆ มำ

สร้ำงรำยได้แบบ Passive Income ไปด้วยกนัครบั 

บทนำ
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VIII

บ ท นํ า

หนังสือเล่มนี้สร้างมาเพื่ออะไร?
หนังสือเล่มนี้สร้ำงมำส�ำหรับผู้สนใจกำรวำดภำพเวกเตอร์ ด้วยโปรแกรม Illustrator เพื่อส่งขำยภำพที่เว็บ 

Shutterstock สร้ำงรำยได้โดยเฉพำะ

�	รู้จกัโปรแกรมวำดภำพเวกเตอร์ Adobe Illustrator และกำรลงทะเบยีนซื้อและตดิตั้งโปรแกรม 

�	รู้จกักำรวำดภำพเวกเตอร์ด้วยโปรแกรม Illustrator ด้วยเทคนคิต่ำงๆ

�	รู้จกัวธิกีำรเตรยีมไฟล์ภำพเวกเตอร์ เพื่อให้ผ่ำนกฎของเวบ็ขำยภำพออนไลน์

�	รู้จกัเวบ็ขำยภำพ และกำรสมคัรสมำชกิที่เวบ็ Shutterstock
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เมื่อคณุวำดภำพเวกเตอร์ได้แล้ว ถ้ำต้องกำรจะขำยภำพต่ำงๆ นั้น กม็เีวบ็ขำย

ภำพเวกเตอร์มำกมำยที่สำมำรถอพัโหลดไฟล์เพื่อขำยภำพ ขอยกตวัอย่ำง 5 เวบ็หลกั

ที่คนรู้จกักนัแพร่หลำย เช่น Shutterstock (SS), Dreamstime (Dt), Fotolia (Fl), 123rf 

(123) และ Istockphoto(IS), ส�ำหรับบทนี้จะแสดงวิธีจัดกำรไฟล์ภำพเวกเตอร์ให้

สำมำรถส่งได้ทั้ง 5 เวบ็ดงักล่ำวในครำวเดยีวกนั แต่จะขอเน้นไปที่ Shutterstock (SS)

สมัครขายภาพเวกเตอร
PART
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ไฟล์ส�าหรับส่งขายที่ 5 เว็บหลัก
ในกำรเตรียมไฟล์ภำพเวกเตอร์เพื่อให้สำมำรถส่งภำพขำยได้ สำมำรถจัดกำรไฟล์ในครำวเดียวและส่งขำยได้

ทั้ง 5 เวบ็โดยมหีลกัดงันี้

�	ชนิดของไฟล์ ไฟล์ภำพในกำรส่งขำยที่เวบ็ขำยภำพ จะต้องเป็นไฟล์ Eps10 และ Jpg ซึ่งทั้งสองไฟล์จะต้อง

เป็นชื่อเดยีวกนั กส็ำมำรถส่งไฟล์ภำพที่ 4 เวบ็ด้ำนซ้ำยได้ ส�ำหรับเวบ็ Fotolia จะต้องส่งโดยกำร Zip ซึ่งเรำจะ

ต้องสร้ำงโฟลเดอร์ แล้วน�ำไฟล์ eps กบั jpg ใส่เข้ำไปก่อน แล้วจดักำรใช้ Winzip บบีอดัเข้ำไป กพ็ร้อมส่งไฟล์

เวกเตอร์ลงเวบ็แล้ว

NOTE
ปัจจุบัน Shutterstock ไม่จ�ำเป็นต้องส่งไฟล์ JPG แล้ว ให้ส่งเพียงแค่ไฟล์ EPS10 ไปอย่ำงเดียว
เท่ำนัน้ ถือว่ำสะดวกมำกๆ

�	ขนาดไฟล์ ที่สำมำรถส่งเวบ็ขำยภำพ ทั้งสองไฟล์คอื Eps10 และ Jpg รวมกนัจะต้องไม่เกนิ 15 mb  

หำกบนัทกึไปแล้วปรำกฏว่ำไฟล์มขีนำดเกนิ 15 mb 

ให้เปิดไฟล์ Eps แล้วปรบัย่อขนำดรูปให้เลก็ลง แล้วบันทกึ

ไฟล์ใหม่ จะท�ำให้ได้ขนำดไฟล์ที่เล็กลง (รูปขนำดเล็กจะ

ไม่มผีลต่อควำมคมชดัของรปู เพรำะไฟล์เวกเตอร์ย่อขยำย

ได้โดยไม่เสยีคณุภำพ)
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�	ภาพ Preview กำร Export ไฟล์และกำรก�ำหนด

ค่ำควำมละเอยีดภำพ บำงเวบ็จะรบัไม่เท่ำกนัก็

จรงิอยู่ แต่เพื่อให้รองรบักบัทั้ง 5 เวบ็ ไฟล์ Jpg 

ควรก�ำหนดควำมกว้ำง x ยำวอยู่ที่  5000 pixel 

ขึ้นไป ค่ำควำมละเอยีดภำพจะอยู่ที่ 300 ppi 

�	การใช้ Effect ในงานขายภาพเวกเตอร์ Effect ที่ปลอดภยัและส่งผ่ำนกค็อื Effect ของโปรแกรม Illustrator 

(ยกเว้นหมวด Stylist > สำมำรถใช้ได้แค่ Scripble) 

กรอบสีสมเปน Effect ของโปรแกรม Illustrator

�	เปลี่ยนเส้นขอบ Stroke ให้เป็นภาพเวกเตอร์ เพื่อให้รองรบักบั 5 เวบ็ดงักล่ำว เรำจะต้องเปลี่ยนเส้นขอบ

ตวักำร์ตูนเป็นภำพเวกเตอร์ ด้วยค�ำสั่ง Expand Stroke ให้เป็น Fill ถงึจะสำมำรถส่งภำพได้ ค�ำสั่ง Expand จะ

อยู่ที่เมนู Object > Expand…
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กรณใีนงำนมกีำรใช้ไล่ส ีGradient อยูด้่วย เมื่อใช้งำน Expand ให้คลกิช่อง Fill ออก ไม่อย่ำงนั้นจะส่งไฟล์ภำพไม่ผ่ำน

�	เปล่ียนฟอนต์เป็นภาพเวกเตอร์ กรณีที่ต้องมีฟอนต์อยู่ในภำพเวกเตอร์ ให้ Create Outlines ด้วยค�ำสั่งนี้ 

สำมำรถเรยีกใช้ได้โดยคลกิเมนู Type > Create Outlines หรอืกดปุ่ม  +  + O

เตรียมภาพเวกเตอร์เพื่อส่งขาย Shutterstock

ขอยกตวัอย่ำงกำรเตรยีมไฟล์ภำพเวกเตอร์เพื่อส่งขำยเวบ็ Shutterstock เวบ็ขำยภำพสดุฮติ ว่ำควรเตรยีมไฟล์ขนำด

ไหน ไฟล์สกลุอะไร บนัทกึยงัไงให้ถูกต้องและผ่ำนกำรสอบของ Shutterstock รวมถงึวธิกีำรสมคัรเป็นสมำชกิของเวบ็นี้กนั 

แต่ก่อนอื่นมำดูวิธกีำรเตรยีมไฟล์ภำพกนัก่อน
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เตรียมหนากระดานวาด Artboard

ในกำรส่งภำพเวกเตอร์ไปยงัเวบ็ Shutterstock.com เรำจะส่งแค่ไฟล์สกลุ EPS10 ที่มขีนำดไม่เกนิ 15 mb มำดูวธิี

กำรก�ำหนดค่ำหน้ำกระดำนวำดให้ได้ขนำดไฟล์เวกเตอร์ดงัต้องกำร รวมถงึกำรก�ำหนดค่ำโหมดส ีColor Mode เป็น RGB 

และค่ำควำมละเอยีดภำพ Raster Effects ที่สำมำรถส่งยงัเวบ็ขำยภำพนี้กนัก่อน ด้วยวธิดีงันี้

1. กดปุม่  +  สร้ำงหน้ำกระดำนใหม่

ขึ้นมำ

2. ก�ำหนดหน่วยวดั Unit : Pixels

3. ปรบัค่ำขนำดกระดำนวำด Width 1200 px 

และ Hight 1200 px

4. คลกิ Advanced Options

5. คลกิเลอืกโหมดสเีป็น RGB

6. คลิกเลือกค่ำควำมละเอียดภำพ High 

(300 ppi)

7. คลกิปุ่ม Create

2

4

8. จะได้กระดำนวำดลกัษณะดงัรูป

1

3

5

7

6

8
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นำตัวการตูนมาจัดวางในกระดานวาด Artboard
เปิดไฟล์กำร์ตูนที่เตรยีมไว้ Part 1 > D-Robot.ai น�ำมำจดัวำงในกระดำนวำดที่เตรยีมไว้ จำกนั้นเรำจะสร้ำงพื้นหลงั

ให้พอดกีบักระดำน Artboard ด้วยวธิดีงันี้

1. กดปุ่ม  +  เพื่อเลอืกไฟล์ภำพทั้งหมด

2. กดปุ่ม  +  เพื่อคดัลอกภำพกำร์ตูน

6. กดปุม่  + คลกิ พื้นที่

ว่ำงเพื่อออกจำกกำรเลอืก

ภำพเวกเตอร์

1

2

4

3

5

6

3. คลิกที่หน้ำกระดำนวำด

ที่สร้ำงไว้ก่อนหน้ำนี้

4. กดปุ่ม  +  วำง

ภำพ เ วก เ ตอ ร ์ ล ง ใ น

กระดำนวำด

5. น�ำเมำส์วำงที่มุมภำพ 

พร้อมกบักดปุ่ม  + 

แดรกเมำส์ ขยำยภำพให้

สวยงำม

B Vector.indb   6 15/6/2563 BE   17:32



7

2)
9�ร
ายภ

าพ
เวกเตอร์

P A R T 01

NOTE

7. คลิกช่องสี Fill เลือกสี

พื้นที่ต้องกำร

8. คลกิเครื่องมอื Rectangle 

Tool

9. คลิ กที่ หน ้ ำ ก ร ะดำน 

แล้วก�ำหนดค่ำพื้นหลัง 

1200 px X 1200 px

10. คลกิ OK

10

8
9

7

11. คลกิเครื่องมอื Selection 

Tool

12. คลกิจดักรอบสี่เหลี่ยมให้

พอดกีบักระดำนวำด

13. กดปุ่ม  +  + 

 เพื่อให้กรอบสี่เหลี่ยม

อยู่ด้ำนหลงัตวักำร์ตูน

14. กดปุม่  + 0  เพื่อให้

กระดำนวำดเต็มหน้ำจอ

พอด ี

11

12

กำรกดปุ่ม  + 0

เพื่อให้กระดำนวำดมขีนำด
พอดีเมื่ อผู้อ่ำนเปิดไฟล์
ภำพที่ โหลดขึ้นมำ ภำพ
ของเรำจะแสดงให้ เ ห็น
ชัดเจนสวยงำม ไม่ย่อจน
เลก็ หรอืขยำยจนใหญเ่กนิ
ไปนั่นเอง

13

14
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Save บันทึกไฟล
เมื่อจดักำรตวักำร์ตนูและพื้นหลงัภำพให้อยูใ่นกระดำนวำดเรยีบร้อยแล้ว มำถงึขั้นตอนกำรบนัทกึไฟล์เป็นนำมสกลุ 

.Eps 10 ซึ่งท�ำได้ดงันี้

1. กดปุ่ม  +  +  ค�ำสั่งบนัทกึ

ไฟล์ใหม่ Save As

2. ตั้งชื่อ File

3. คลกิเลอืกสกลุไฟล์ .EPS

4. คลกิ Save

5. คลกิเลอืก Version : Illustrator 10 EPS ลดเวอร์ชัน

โปรแกรมลงตำมที่เวบ็ไซต์ระบขุ้อตกลงไว้

6. คลกิ Preset : High Resolution ค่ำควำมละเอยีด

สูงสดุ

7. คลกิ OK เสรจ็เรยีบร้อยส�ำหรบักำรบนัทกึไฟล์ EPS

Export ไฟล
ส�ำหรบัเวบ็ SS ไม่จ�ำเป็นต้องส่งไฟล์ Jpg 

แล้ว แต่จะแนะน�ำวิธีกำร Export ไฟล์เป็นภำพ 

Jpg ส�ำหรบัผู้ที่ต้องกำรน�ำภำพไปใช้งำน หรอืส่ง

ไฟล์ขำยที่เวบ็อื่นๆ นอกเหนอืจำกเวบ็ SS ซึ่งกำร 

Export ไฟล์ ท�ำได้ดงันี้

1. กดปุ่ม  +  เพื่อเลือกภำพ

กำร์ตูนทั้งหมด

2. คลกิที่ Transform 

3. คลกิรูปโซ่

4. คลกิปรบัค่ำ 5000 px เพื่อให้ภำพ Jpg 

มขีนำดใหญ่เกนิสี่ล้ำนพกิเซล ตำมที่

เกอืบทกุเวบ็ขำยภำพก�ำหนด

1

2

6

3

4

7

1

2

5

4

3
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5. คลกิเมนู File > Export > Export as

6. ชื่อไฟล์จะตรงกบัไฟล์ Eps

7. คลกิเลอืกนำมสกลุ JPG

8. คลกิ Export

9. คลกิโหมดส ีRGB

10. ปรบัคณุภำพสูงสดุ Ouality : 10 Maximum

11. ค่ำควำมละเอยีด Resolution : High (300 ppi)

12. คลกิ OK จะได้ไฟล์ภำพ Jpg เรยีบร้อย

NOTE
เมื่อ Export ไฟล์ Jpg ออกมำแล้ว ห้ำมไปปรับแต่งสีเพิ่มเติมในโปรแกรม Photoshop โดยเด็ดขำด 
เพรำะจะท�ำให้ภำพ Jpg กับภำพ Eps สีไม่เหมือนกัน ทำงเว็บขำยภำพจะถือว่ำเป็นคนละรูป ผลคือ 
จะไม่ผ่ำนกำรสอบ และโดน Reject กลับมำให้แก้ไขใหม่
อย่าลืมท่ีจะคลิกปิดไฟล์ทิ้งไปและห้ามบันทึกไฟล์ EPS ซ�้ า เพราะก่อนหน้านี้เราได้บันทึกไฟล์ 
EPS ที่เรียบร้อยไว้ก่อนแล้ว

12

8

11

10
9

6

7

5
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สมัครสมาชิก (SS) Shutter Stock
ปัจจุบันกำรสมัครสมำชิกที่เว็บนี้ท�ำได้ง่ำยมำกๆ เป็นเว็บที่รองรับภำษำไทย รวมถึงกำรสอบภำพก็ไม่ยุ่งยำก 

แค่สอบผ่ำนเพยีงหนึ่งภำพกจ็ะสำมำรถหำเงนิจำกเวบ็นี้ได้แล้ว มำสมคัรสมำชกิเพื่อขำยภำพเวกเตอร์กนัดกีว่ำ

1. เปิดเวบ็ไซต์พมิพ์ https://submit.shutterstock.com/ แล้วกดปุ่ม 

2. คลกิเลอืกภำษำไทย 

3. คลกิปุ่ม สมคัรใช้งำน

4. พมิพ์ชื่อ-สกลุ ภำษำองักฤษ 

5. พมิพ์ชื่อ User ที่แสดงให้ลูกค้ำเหน็

6. กรอกอเีมลของเรำ

7. พมิพ์รหสั Password โดยจะต้องใช้ภำษำองักฤษเป็นตวัพมิพ์ใหญ่น�ำหนำ้ หลงัจำกนั้นจะใช้ตวัเลขหรอืตวัพมิพ์

เลก็กไ็ด้ให้ครบ 8 ตวัอกัษรขึ้นไป

8. คลกิเครื่องหมำย ü ยอมรบัเงื่อนไข

9. คลกิปุ่ม ถดัไป

1
3

2

4

5

6
7

8

9
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10. เข้ำไปตรวจสอบอเีมลเพื่อยนืยนัควำมถูกต้อง

11. เปิดอเีมลที่ใช้สมคัรก่อนหน้ำนี้ > คลกิที่ โปรโมชั่น

12. คลกิเปิดอเีมลยนืยนัที่อยู่ จำก Shutterstock ขึ้นมำ

13. คลกิ โปรดคลกิที่นี่เพื่อยนืยนัอเีมลของคณุ

10

11

12

13
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14. คลกิปุ่ม ถดัไป

14

15. ระบปุระเทศ

16. กรอกรำยละเอยีดเป็นภำษำองักฤษ ทั้งชื่อที่อยู่และเบอร์โทร โดยจะต้องเป็นที่อยูจ่รงิ เพรำะ Shutterstock ต้อง

ส่งใบภำษมีำที่บ้ำนในกรณทีี่มกีำรซื้อขำยเกดิขึ้น

17. คลกิปุ่ม ถดัไป จะเข้ำสู่ขั้นตอนกำรส่งภำพแล้ว

15

16

17

ขั้นตอนการสงภาพ
ในตอนเริ่มต้นเรำได้เตรยีมไฟล์ภำพเวกเตอร์ สกลุ EPS 10 ไว้แล้ว มำถงึขั้นตอนกำรส่งภำพกนั เวบ็ SS ได้รองรบั

ภำษำไทย ท�ำให้ง่ำยต่อกำรอ่ำนเงื่อนไขต่ำงๆ ในกำรส่งภำพ แต่ถงึกระนั้นกำรส่งภำพ กำรตั้งชื่อไฟล์ ยงัต้องตั้งชื่อและ

ค�ำอธิบำยภำพเป็นภำษำอังกฤษอยู่ หำกใครไม่ถนัดภำษำอังกฤษ แนะน�ำใช้ Google Translate ช่วยก็ได้ กำรส่งภำพ

เวกเตอร์ท�ำได้ดงันี้
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1. คลกิปุ่ม อปัโหลดภำพ

2. อ่ำนค�ำแนะน�ำต่ำงๆ จำกนั้นคลกิปุ่ม เข้ำใจแล้ว!

1

2

3. คลกิปุ่ม เลอืกหลำยไฟล์

3
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4. แดรกเมำส์เลอืกไฟล์ที่ต้องกำรอพัโหลด (สำมำรถเลอืกหลำยๆ ภำพในครำวเดยีวได้เช่นกนั)

5. คลกิปุ่ม Open

6. รออพัโหลดไฟล์จนเสรจ็ 100%

7. คลกิปุ่ม ถดัไป

4

6

5

7

8. เมื่ออ่ำนค�ำแนะน�ำเสรจ็แล้ว ให้คลกิปุ่ม เริ่มใส่รำยละเอยีด

8
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9. คลกิเลอืกภำพ

10. พิมพ์ค�ำอธิบำยเกี่ยวกับภำพเป็นภำษำอังกฤษ ควำมยำวไม่ต�่ำกว่ำ 30 ค�ำ เขียนให้เป็นประโยคที่เข้ำใจ

ควำมหมำยของภำพได้ ซึ่งจะมผีลต่อกำรค้นหำภำพง่ำยขึ้น

11. คลกิเลอืกหมวดหมู่ของภำพว่ำอยู่ในประเภทใด (ต้องเลอืกอย่ำงน้อย 1 ประเภท)

12. คลกิเลอืก ตวัเลอืกเพิ่มเตมิ (ตำมต้องกำร)

9 10

11

12

13. คลกิเลอืกภำพประกอบที่ไม่มขี้อมูลอ้ำงองิ เนื่องจำกเป็นภำพที่เรำวำดขึ้นเอง

13
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14. คลิกเลือกคีย์เวิร์ดที่เกี่ยวข้องกับภำพ ซึ่งทำงเว็บจะประมวลคีย์เวิร์ดให้บำงส่วน (คีย์เวิร์ดไม่ควรน้อยกว่ำ 7 

คยี์เวริ์ด)

15. คลกิ พบค�ำค้นหำเพิ่มเตมิ เพื่อหำคยี์เวริ์ดเพิ่ม (คยี์เวริ์ดที่เกี่ยวข้อง คยี์เวริ์ดยิ่งมำก ยิ่งท�ำให้ลูกค้ำสำมำรถเจอ

ภำพเรำได้ง่ำยขึ้น)

16. พมิพ์ข้อควำมที่จะค้นหำ และเลอืกประเภทภำพที่ต้องกำรค้นหำ

17. คลกิปุ่ม ค้นหำ

18. คลกิเลอืกภำพแนวที่คล้ำยคลงึกบัภำพของเรำ (อย่ำงน้อย 3 ภำพ)

19. คลกิเลอืกคยี์เวริ์ดเพิ่มเตมิ

14

15

16

17

18

19
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20. คลกิ ใช้กบัรำยกำรที่เลอืก

20

21. คลกิ ส่ง 

21
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ภาพที่ผานและไมผานการสอบ
เมื่อส่งภำพไปสอบเรยีบร้อย รอเวลำ 1–5 วนั ให้กลบัมำเชค็ที่ https://submit.shutterstock.com/ เพื่อดูว่ำภำพผ่ำน

หรอืไม่ผ่ำน หำกผ่ำนกพ็ร้อมขำย แต่หำกไม่ผ่ำนกจ็ะต้องแก้ไขตำมค�ำแนะน�ำจำกเวบ็แล้วส่งใหม่ ดงันี้

1. คลกิปุ่ม ลอ็กอนิ

1

2. พมิพ์อเีมลและรหสัผ่ำนที่ใช้สมคัรก่อนหน้ำนี้

3. คลกิเครื่องหมำยถูก ü ฉนัไม่ใช่โปรแกรมอตัโนมตัิ

4. คลกิปุ่ม ลงชื่อเข้ำใช้

5. คลกิที่ รอกำรอนมุตั ิจะเหน็จ�ำนวนภำพที่ส่งแล้วก�ำลงัรอกำรอนมุตัิ

5

4

3

2
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6. เมื่อภำพถูกอนมุตัเิรยีบร้อยแล้วจะแสดงที่ ได้รบัพจิำรณำแล้วเรว็ๆ นี้

7. เมื่อคลกิเข้ำไปจะแสดงชื่อภำพ และเครื่องหมำย ü สเีขยีว ถ้ำไม่ผ่ำนจะเป็นเครื่องหมำย û		สแีดง และ

มรีำยละเอยีดให้เรำแก้ไขตำมค�ำชี้แจงแล้วส่งใหม่

6

7
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อัพโหลดภาพเมื่อผานการสอบแลว
เมื่อสอบภำพผ่ำนแล้ว กส็ำมำรถส่งภำพขำยได้ต่อไปเรื่อยๆ เลย ข้อส�ำคญัห้ำมดรำฟต์ลอกงำน เปลี่ยนส ีหรอืตดัแต่ง

บำงส่วนแล้วส่งขำย มันคือควำมผิดร้ำยแรง คุณจะโดนปิดพอร์ตแน่นอน โดยกำรอัพโหลดภำพให้เข้ำไปที่เว็บหลักของ 

shutterstock.com แล้วท�ำตำมขั้นตอนดงันี้

1. เปิดหน้ำเวบ็หลกัแล้วคลกิ เข้ำเป็นช่ำงภำพ

2. คลกิปุ่ม อพัโหลดภำพ 

3. คลิกปุ่ม เลือกหลำยไฟล์ แล้วเลือกภำพตำมต้องกำร และท�ำขั้นตอนกำรส่งภำพดังที่กล่ำวมำแล้วในหัวข้อ

กำรส่งภำพก่อนหน้ำนี้

1

2

3
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กรอกแสดงการเสียภาษีใน Shutterstock

เรำจ�ำเป็นต้องกรอกภำษส่ีวนนี้ เพรำะไม่อย่ำงนั้นเรำจะต้องเสยีภำษถีงึ 30% จำกยอดขำยส�ำหรบัพลเมอืงอเมรกินั 

สมมตเิรำขำยภำพได้ 1,000 บำท จะถูกหกัไป 300 บำทเลยทเีดยีว ซึ่งถอืว่ำสูงมำกส�ำหรบัคนไทย ส�ำหรบัคนต่ำงชำตจิะ

ถูกหกัภำษเีพยีงแค่ 5% จำกยอดขำย หำกรำยได้ 1,000 บำท ถูกหกัแค่ 50 บำทเท่ำนั้น รบีมำกรอกภำษกีนัดกีว่ำ ด้วย

ขั้นตอนดงันี้

1. เข้ำมำในหน้ำบญัชผีู้ใช้ของเรำ คลกิ รำยได้ > ศูนย์ภำษี

1

2. คลกิ ส่งแบบฟอร์มกำรเสยีภำษใีหม่ 

2
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3. คลกิเลอืก ไม่ เพื่อยนืยนัว่ำไม่ใช่บคุคลอเมรกินั

4. คลกิเลอืก บคุคล หำกเป็นรูปแบบธรุกจิ ให้คลกิเลอืก ธรุกจิ จำกนั้นคลกิปุ่ม ส่ง

3

4

5. กรอก (1) ชื่อ-นำมสกลุ (2) ประเทศไทย (3) ที่อยู่ เป็นภำษำองักฤษ โดยสะกดให้ตรงกบับตัรประชำชน

6. คลกิเลอืก No 

6

5

B Vector.indb   22 15/6/2563 BE   17:33


